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Introduction

After a year and a half at Texas A&M University, I decided to take advantage of the free computer resources 
available to students.    I wanted to create a home page.    However, as I got into the coding of HTML, I found 
that there are too many tags and options to remember and too much volatility in the HTML standard to stay up 
to date.    So I searched around to find the perfect editor that allowed me to easily add everything I wanted to 
add.    Unfortunately, in the mosaic of editors available on the Internet, none had every option in the right place 
with the right menu with the right shortcut.    Instead, I set out to develop my own solution, MatHTML, with all 
the bells and whistles exactly where I expect them to be.    Originally, MatHTML was only for my personal use, 
but as development continued, I decided that it was worthy software that may be of benefit to others that use the 
Internet.    And so, that’s how this project began.    It continues to grow as HTML grows, gets easier to use as I 
discover better ways of doing things, and becomes more popular as users see comments and suggestions quickly 
implemented.    I hope that you find MatHTML to be the best product of its kind on the market.    Your 
participation in bug reports, suggestions, and registration is encouraged and appreciated.

Help

MatHTML’s Help System consists of a convenient follow-along in-line HTML reference that also describes and 
explains many MatHTML features.    While this reference is in no way comprehensive, it does serve as an 
excellent guide for the HTML beginner and intermediate.    For further information, search the World Wide Web 
at http://www.w3.org and other HTML related sites.    To activate the Help System, press F1 or choose Index 
from the Help menu.    Context-sensitive help is available by placing the cursor or highlighting text between the 
< and > characters of an HTML tag, then right-clicking on the editor and selecting Help.

Hot Keys

Control A Select All
B Bold
C Copy
D Date
E Anchor
F Font
G
H Heading
I Italic
J
K
L List Item
M Image
N New
O Open
P Paragraph
Q Marquee
R Horizontal Rule
S Save
T Table



U Underline
V Paste
W Special Character
X Cut
Y Line Break
Z Undo

Control & &
< <
> >
. …
ENT Paragraph
- Horizontal Rule
SPC Non-Breaking Space
? ¿
! ¡

Ctrl-Alt C Copyright
R Registered Trademark
T Trademark
ENT Line Break

Working With Files

The File Menu

Working with files in MatHTML is simple.    To create a new document, open an existing document, save the 
current document, or save the current document under a different name, select the appropriate menu command 
from the File menu.    The four file names near the bottom of the menu are the most recently used files and can 
be opened quickly by clicking the desired name.    A file can also be opened by dragging its icon onto the editor 
window.    However, this method does not currently prompt to save before opening.    To preview your work in 
your system’s default web browser, select Preview in Default Browser.    To preview your work in another 
browser of your choice, click Preview in Selected Browser.    The Selected Browser is configured in 
Preferences.    To select a default printer or to set other print options, choose Print Setup.    To print the current 
HTML document or highlighted text, choose Print or Print Selected Text.

Select Preferences to configure MatHTML options.    Under the Editor Options tab, set the case with which 
HTML tags are inserted.    The editor font is listed in the Font box and can be changed through the Font 
command button.    To use relative path links when inserting anchors, images, and files, check the Relative Path 
Links checkbox.    If this option is not selected, the full path of files will be used.    Note that files must be saved 
to compute a relative path.    If a file is not saved, the Relative Path Link checkbox on the individual tag form 
will not be available.    Many browsers do not recognize the backslash as a path separator, therefore select the 
Convert \ to / checkbox to change the separators to forward slashes.    To avoid losing unsaved work, set the 
AutoSave option.    To disable the AutoSave feature, set the value to zero.    The URL History is a list that stores 
recently used URLs from Anchors, Images, and other files.    Its size can be limited with the URL History Size 
option.    Select the Show Only Relevant URLs in History checkbox to display only images in the Image dialog, 
only sounds in the Background Sound dialog, and so forth.    Indicate in the Browser Path box the full path to 
your desired selected browser or choose a program file through the Browse command button.    The Highlight 
Options tab allows the user to select several options for highlighting HTML tags.    Six colors can be chosen to 
highlight different types of tags.    Checking the Highlight On Open checkbox will invoke the highlighting 
routine each time a new file is opened.    Selecting the Highlight As You Type option will turn highlighting on 
when the editor detects a < key and off when it detects a > key.    This feature always uses the default highlight 
color no matter what tag is typed.    The Popup Menu tab allows the user to customize the Right Mouse Button 



Popup Menu that appears in the editor window.    Any menu command from Edit to Special can be selected. To 
save all of these options, click the Close command button.    Choosing Cancel will exit without saving changes.

MatHTML is ShareWare.    The MatHTML Visual Basic executable and the MatHTML help file are copyright 
materials to the author, Matthew Roberts.    As such, MatHTML, in only its original unmodified form, may be 
freely distributed and used for a trial period of 45 days.    However, if use of MatHTML extends beyond the trial 
period, registration with the author is required.    Unregistered use of MatHTML after the 45 day evaluation 
term is in violation of United States and international copyright laws.    All users, registered or otherwise, are 
specifically prohibited from charging a fee or requesting a donation in return for this software, from distributing 
this software or documentation with other products without prior permission, from distributing registration 
information, and from decompiling, reverse engineering, or otherwise tampering with the executable source 
code or documentation.    See below for information on how to register and other information.    Registered 
users may enter registration information on the Register MatHTML tab of Preferences and click the Register 
command button to register the software.

To uninstall MatHTML, click the UnInstall command button and confirm the request.    This action will remove 
MatHTML configuration settings from the registry.    To complete the uninstallation process, remove MatHTML 
through the Add/Remove Programs Control Panel.    In upgrading MatHTML, it is recommended to remove the 
previous installation first, but through the Control Panel only in order to retain configuration settings and 
registration information.

The Edit Menu

The first five Edit menu options are common Windows 95 controls.    Choose Cut, to remove selected text from 
the editor and save it to the Clipboard, Copy to copy selected text to the Clipboard, Paste to insert the contents 
of the Clipboard in the editor at the cursor, Delete to remove selected text from the editor without saving it to 
the Clipboard, and Select All to select all of the text in the editor window.    To reverse an action in editing or in 
typing, press Control-Z, the shortcut for Undo.    Use Find & Replace to search the document for specific text.

Clicking Highlight HTML Tags will highlight all HTML code with the appropriate color.    If any text in the 
editor is selected, only that text is processed for highlights; otherwise, the entire file is processed.    To remove 
all of the highlighting, select Remove Highlights.    To remove all HTML code from the document, choose 
Remove HTML Tags.    If any text in the editor is selected, only tags within that text are removed; otherwise, the 
entire file is processed.    Be careful as there is no reversing this procedure except to reopen a saved file.    The 
MatHTML Tag Checker can be started with the Check HTML Tags menu option.    The Tag Checker is only a 
small utility that checks to ensure that tags are properly closed, and that none overlap.    It is by no means 
comprehensive but does help to eliminate common mistakes.

The Insert Menu

Choose Color Code to insert a valid color name or valid hexadecimal format color code.    The following are 
examples of the Microsoft Internet Explorer color names.

Aqua Black
Blue Fuchsia
Gray Green
Lime Maroon
Navy Olive
Purple Red
Silver Teal
White Yellow



To insert the current date, choose Date and select an appropriate format.    To insert the contents of a text or 
HTML file, choose File, then select or enter the name of a valid file.    To insert a special character, such as < or 
> which are used as code rather than text, select the desired character from the Special Character submenu; or, 
for more options, choose More.

Insert Standard HTML Tags will paste in a simple HTML template to begin a web page.    The Template option 
offers a selection of several different templates.    The MatHTML Courtesy Tag is a small advertisement to 
promote this editor with viewers of a web page created with MatHTML.    It is requested by the author, but not 
required, that authors use this tag if a significant portion of a document is edited with MatHTML.

Adding HTML Elements

Anchor

An Anchor is a hyperlink to another HTML document, a WWW site, an FTP site, or a number of other Internet 
sites that follow the Universal Naming Convention.    Exact file locations can be used to create pages for static 
Intranets or LANs.    To anchor to a bookmark within an HTML document, append a # character to the filename 
followed by the bookmark name.    If a series of documents are related with frames, use the Target Frame option 
to direct the anchor to open in a specific window.    The reserved frame names have special meaning and should 
not be used as the name of any user-created frames.    “_blank” causes the anchor to load in a new window; 
“_self” causes the anchor to load in its own frame; “_parent” causes the anchor to load in its parent frame (if 
there is no parent frame, _self is used); “_top” causes the anchor to load in the topmost frame of the document 
(if the anchor is at the top, _self is used).

Bookmark

Bookmarks are specific locations within HTML documents.    The actual text of a Bookmark is not visible 
within a WWW browser.    However, anchoring to a Bookmark, using the # character, will cause the browser to 
scroll up or down to the text following the Bookmark.    If a URL is not specified in the anchor, the Bookmark is 
assumed to be in the current document.

Example:
<A NAME=“top”>
<A HREF=“http://www.company.com/index.html#top”>
<A HREF=“#top”>

Line Break

Line Breaks are used to divide lines at specific points rather than allowing the browser to wrap them to the 
window.    Clear options force the following line to begin below any left, right, or all floating images or tables.    
Multiple Line Breaks are cumulative.

Comment

Use Comments to include hidden information in a web document.    Text between the delimiters, including 
HTML text, will not be displayed in the browser.    However, the <COMMENT>…</COMMENT> tag is 
Microsoft Internet Explorer specific and hides only non-HTML text.



Heading

A Heading introduces a section of an HTML document. It is usually rendered in a large bolded or italicized font 
and is always separated by a carriage return above and below.    Headings can be left aligned or centered by 
selecting the appropriate option.

Horizontal Rule

Horizontal Rules are beveled lines used as separators.    Its appearance can be changed by setting the Width, 
Size, and Shading options.    Width can be any pixel value or percentage of screen width.    Size can be any pixel 
value and determines the height of the rule.    Selecting the No Shading option causes the rule to be displayed as 
a solid line rather than beveled.    Use the Alignment option to left, center, or right justify the rule.    The Color 
setting changes the color of the lines used to render the rule, but it is currently supported only by Microsoft 
Internet Explorer 3.0.    See the Color section for examples of the sixteen color names.

Image

Insert an in-line graphic into a web page by selecting the Image element.    Use the Alignment option to indicate 
how succeeding text should be formatted.    Selecting either Left or Right will cause the image to “float” against 
the specified border with text wrapping around it.    Use the Height and Width tags to indicate the size of the 
graphic. Browsers use this information to draw a placeholder until the image can be downloaded.    Both options 
can be any pixel value or percentage of screen size, and the image will be rendered according to those 
dimensions.    Border, HSpace, and VSpace set a certain amount of space around the image where text and other 
images cannot invade.    Border indicates space all around the image, while HSpace and VSpace indicate space 
only to the left and right or above and below.    All of these options can be any pixel value.    The Alternative 
Text option is for specifying an appropriate placeholder for text-only browsers.    To indicate that an image is a 
Client-Side Image Map or an Image Sensitive Map (Server-Side), select the CSIM or ISMAP checkbox.    Both 
can be selected to provide for browsers that do and browsers that do not support the new Client-Side Image 
Map specification.    The CSIM option requires a mapname, but the ISMAP option does not and will instead 
default to the anchor surrounding the image.    To insert in-line videos or virtual worlds, click the Dynamic 
Image button.    The VRML image tag is currently supported only by Microsoft Internet Explorer.    The Loop 
and Loop Delay options indicate how many times an in-line video should repeat and how long, in seconds, the 
video should pause between loops.    The Start options set when an in-line video should begin: when it finishes 
downloading, when the user places the cursor over it, or both.    To display playback controls with the video, 
check the Controls checkbox.

Paragraph

Use the Paragraph element to indicate where to begin a new section.    The Alignment option justifies text that 
follows.    Note that the Right Justified element can use a non-standard table construction.    This is because 
some browsers does not correctly support right justification.    However, the table tags will overcome this 
limitation and should work in all browsers.

Base Font

The Base Font tag sets the default Face, Size, and Color of text in the HTML document.    Selecting more than 
one font face allows the author to provide settings for systems that do not have the primary fonts installed.    If 
none of the selected fonts are installed, the browser will render with a default font.    Changing font faces is 
currently supported only by Microsoft Internet Explorer.    See the Color section for examples of the sixteen 
color names.



Body

Body settings indicate global options to display the HTML document.    The Background Source sets a graphic 
to be tiled as a wallpaper for the page.    Selecting the Watermark Effect prevents the background from scrolling, 
and instead the text scrolls over the background.    Watermarks are currently supported only by Microsoft 
Internet Explorer.    Color options change the default color for the background, text, hyperlinks, and visited 
hyperlinks.    Also, the author can select a predefined Color Scheme for the document or save a frequently used 
scheme for later use.    An example of how the page should appear is displayed to the right.    Left and Top 
Margins can be any pixel value and will leave the specified amount of space above, below, to the left, and to the 
right of the browser window.    Margin settings are currently supported only by Microsoft Internet Explorer.

Title

The Title of an HTML document usually appears in the title bar of the browser window.    Text should be 
enclosed by the Title tags and appear only once in the header of the document.

Base

The Base address is the exact URL of the HTML document.    It is used to calculate the addresses of relative 
links and should appear within the header.    It is not required, and if it does not appear, the file’s current location 
is used as the Base.

IsIndex

The IsIndex tag indicates that a document is a searchable index.    The Action attribute should point to a properly 
configured script to process requests.    If the Action attribute is not added, the request is posted to the current 
document.    The default prompt is usually “This is a searchable index. Enter search keywords,” but can be 
overridden with the prompt option.

Meta

The Meta element is used to embed a broad range of document information not defined by other HTML 
markup.    References for this tag are available throughout the Internet.

Using the Meta tag, authors can create dynamic documents that periodically reload or jump to other pages.    To 
produce the proper markup for dynamic documents, select the Dynamic Document command button.    In the 
dialog box, enter the exact URL address of the document to be referenced.    If no address is specified, the 
current document will be reloaded.    In the second dialog, enter the time, in seconds, to wait before jumping or 
reloading.    The code created with the Dynamic Document Wizard is an HTTP-Equiv value of “refresh” and 
Content value of “seconds; URL=address.”

Applying Styles

To apply styles, such as Bold, Italic, or Underline, to your WWW document, select the text to format in the 
editor, then select the appropriate HTML style in the Style Menu.    If no text is selected, the cursor will appear 
within the beginning and ending tags.



Bold
Italic
Underline
Subscript (Netscape)
Superscript (Netscape)
Big (Netscape)
Small (Netscape)
Blink (Netscape)
Address
Citation
Code
Definition
Emphasis
Keyboard
Listing <A HREF…>
Plaintext <A HREF…>
Preformatted
Sample
Strikethrough
Strike
Strong
Typewriter
Variable
Exempt <A HREF…>

Formatting

To apply formatting, such as Fonts and Justification, to your WWW document, select the text to format in the 
editor, then select the appropriate HTML format in the Format Menu.    If no text is selected, the cursor will 
appear within the beginning and ending tags.

Center

The Center tag is non-standard but widely supported.    It causes everything, including text, images, tables, 
marquees, and most other objects, to be centered between the margins of the browser window.

Blockquote

Use Blockquote to indent slightly on both the left and right sides of a paragraph as is typically done for a long 
direct quote.

Font

The Font tag is similar to Base Font except that it applies only to text within the beginning and ending 
delimiters.    Selecting more than one font face allows the author to provide settings for systems that do not have 
the primary fonts installed.    If none of the selected fonts are installed, the browser will render with a default 
font.    Changing font faces is currently supported only by Microsoft Internet Explorer.    Font Sizes can be 
relative to the Base Font Size setting by adding a plus (+) or minus (-) before the number.    See the Color 
section for examples of the sixteen color names.

No Break

Use the No Break tag to prevent the browser from wrapping lines of text between the delimiters.



Word Break

The Word Break tag is for the rare case when a No Break section requires an exact break.    It can also be used 
anywhere to indicate where a word is allowed to be broken.

Lists

Use Lists to display an index of related items.    Each element of a Directory list, Menu list, Ordered list, and 
Unordered list is preceded by the List Item tag.    Directory and Menu lists are rendered with each item indented 
slightly.    Ordered lists display either a number, letter, or Roman numeral before each item.    To begin the 
numbering at some value other than one, add the Start tag to the opening list tag.    To use an item separator 
other than numbers, add the Type tag to the opening list tag.    To change either the number or separator 
midstream, add either the Value tag or the Type tag to the List Item tag.

Menu or Directory List
Item 1
Item 2
Item 3

Ordered List
1. Item 1
2. Item 2
3. Item 3

Unordered List
· Item 1
· Item 2
· Item 3

Use a Definition list to display a series of terms followed by explanations.    The only option is Compact which 
will cause come browsers to render the term and definition on the same line when space is at a minimum.

Definition Term 1
Definition 1

Definition Term 2
Definition 2

Tables

(Under Construction)

Forms

(Under Construction)

Frames

Frames provide an interesting twist on web page formatting.    A frames-capable browser window can be 
separated into different sections by defining frame sets.    The primary file for a framed document should 
contain only the opening and closing HTML tags, the HEAD tags, but no BODY.    Instead, use a FRAMESET 
tag.    In the Frameset dialog, specify whether the browser should be split into multiple rows, columns, or both. 
In the appropriate table, define sizes for each frame either as a pixel value, as a percentage of screen width, as a 
value relative to other frames (a value of 2* indicates a size of twice that of any other frame), or as all 



remaining space.    Clicking the Auto Fill command button will evenly divide the space among all rows or 
columns.    Selecting OK without indicating sizes will define each frame as all remaining space which browsers 
interpret as equally sized.

The content of each frame is defined in separate HTML files and included as the source within a FRAME tag.    
There should be a frame tag for each frame defined in the frameset, and frames are defined first across rows 
then down columns.    Undefined frames appear blank.    Names are used to target specific frames.    Frames 
without names cannot be targeted from exterior documents.    Use the Scrolling option to specify whether scroll 
bars should appear inside the frame: select Yes to appear always, No to appear never, and Auto to appear only if 
necessary.    Margin Height and Margin Width allow spacing within the frame.    Frame Spacing allows spacing 
around the outside of the frame to give the appearance of a floating frame.    Clear the Frame Border checkbox 
to cause the browser not to render borders around the frame.    Frame Spacing and Frame Border are currently 
supported only by Microsoft Internet Explorer.    Select No Resize to make the frame size static.

After all frames have been defined, add the NOFRAMES tag to provide content for browsers that do not 
recognize frames.    All usual markup can appear between the NOFRAMES tags.

Special HTML Tags

Background Sound

Background Sounds are soundtracks or theme music which play when a web page is opened.    The sound can be 
either WAV or AU format audio samples or MIDI tracks.    Specify a Loop value to indicate the number of times 
the sound should repeat.    This tag can be used more than once in an HTML document and each sound will be 
played consecutively.    The Background Sound element is currently supported only by Microsoft Internet 
Explorer.

In-Line Video

See Image tag for detailed explanation.

Marquee

A Marquee is a section of text that scrolls or bounces across the browser window.    The Behavior setting 
determines whether the marquee scrolls continuously, slides to its boundary and stops, or bounces between its 
boundaries.    Direction indicates which way the marquee scrolls or slides.    Alignment determines how 
surrounding text is rendered against the marquee.    Use the Background Color option to place emphasis on the 
marquee.    The default background color is the background color of the page.    Height and Width can be any 
pixel value or percentage of screen size and set the dimensions of the marquee.    Border, HSpace, and VSpace 
set a certain amount of space around the marquee where text, images, and other marquees cannot invade.    
Border indicates space all around the marquee, while HSpace and VSpace indicate space only to the left and 
right or above and below.    All of these options can be any pixel value.    The speed of the marquee can be set 
using the Scroll Amount and Scroll Delay options.    Scroll Amount can be any pixel value and indicates the 
distance to skip on successive redraws of the marquee text.    Scroll Delay is the time, in milliseconds, between 
the redraws.    The Marquee tag is currently supported only by Microsoft Internet Explorer.

Microsoft ActiveX Objects



Animated Button

Chart

Gradient

Label

New

Popup Menu

Preloader

Stock Ticker

Timer

Custom HTML Tags

Use a Custom Tag to apply unsupported HTML code or to reapply frequently used code by selecting its given 
name or number from the Custom menu.    To add to, delete from, or change the custom tag list, click the first 
menu option, Custom Tag List.    In the Custom Tags table, click the Add command to add, the Edit command to 
edit, or the Remove command to delete.    Also, double-click a tag in the table to edit its properties or double-
click the last row of the table to add a tag.    To exit the custom tag editor without saving changes, choose 



Cancel.    To exit and save changes, choose Close or choose Insert to paste in the current tag before closing.    
Custom tags are nondestructive and are not formatted for case.

Suggestions and Bug Reports

Please submit any suggestions and/or bug reports through the ‘bugreport.htm’ file located in the MatHTML 
directory or through the MatHTML Home Page on the Internet at http://http.tamu.edu:8000/~mar6417/mathtml. 
All comments are welcome and appreciated.

Registration Information

MatHTML is ShareWare.    The MatHTML Visual Basic executable and the MatHTML help file are copyright 
materials to the author, Matthew Roberts.    As such, MatHTML, in only its original unmodified form, may be 
freely distributed and used for a trial period of 45 days.    However, if use of MatHTML extends beyond the trial 
period, registration with the author is required.    Unregistered use of MatHTML after the 45 day evaluation 
term is in violation of United States and international copyright laws.    All users, registered or otherwise, are 
specifically prohibited from charging a fee or requesting a donation in return for this software, from distributing 
this software or documentation with other products without prior permission, from distributing registration 
information, and from decompiling, reverse engineering, or otherwise tampering with the executable source 
code or documentation.

MatHTML can be registered via postal mail by sending a Registration Form, along with the appropriate fee, in 
the form of a personal or corporate check, money order, or cash, to:

Matthew Roberts
P.O. Box 10451
College Station, Texas 77842-0451
U.S.A.

Note, the author is not responsible for registration information or fees lost through the mail.    Include the 
following information about the user: name, return address, email address, company name and address, if 
applicable, number of users, MatHTML version number, URL addresses of any web pages created with 
MatHTML, whether to include 3½” program diskettes and how many sets, payment method, and payment 
amount.    The Registration Form and other information can be found at the MatHTML Home Page at 
http://http.tamu.edu:8000/~mar6417/mathtml or in the About MatHTML box.    As of July 31, 1996, registration 
is $10.00 (ten U.S. American dollars) for individual users developing personal web pages, unlimited 
educational institution use, and unlimited church organization use.    As of July 31, 1996, registration is $5.00 
(five U.S. American dollars) for each user on a corporate network or web page and other business uses, with 
a minimum fee of $50.00 fifty U.S. American(dollars).    If 3½” program disks are required, include an 
additional $2.00 (two U.S. American dollars) per set.    Note, these fees are subject to change without notice.    
Registration Codes will be sent via email or postal mail as soon as the appropriate fees have been received and 
validated.    Registration grants free upgrades for a period of at least six months so long as the registration fee 
remains unchanged, although updates are not guaranteed to be released within that time.    Failure to register 
will cause the initial splash screen to remain visible an extra second for every day of unregistered use.    
Continued development of MatHTML is encouraged through registration.

Sale of Source Code Information

The Visual Basic 4.0 32-bit source code for MatHTML is for sale.    I can no longer offer the extra time and 
effort required to properly support, maintain, and improve this application.    Companies or individuals 
interested in furthering one of the best and most complete HTML text editors available should inquire and/or 
offer a sale price through email at mroberts@tamu.edu with the subject of “MatHTML SCS.”    Only serious 



and fair offers will be considered.    Please mind that more than one thousand hours over a period of six months 
have been poured into the development of over two megabytes of MatHTML code.    Also note that while the 
source code is only sparsely documented, it is written using common naming and style conventions and is quite 
easy to read and follow.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING DOCUMENTATION AND FILES ARE PROVIDED “AS 
IS,” WITHOUT WARRANTY OF ANY KIND WHETHER EXPRESSED OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THE WARRANTIES OF PERFORMANCE OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT.    THE USER MUST ASSUME THE 
ENTIRE RISK OF USING THIS SOFTWARE.    ANY LIABILITY OF THE AUTHOR WILL BE LIMITED 
EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF REGISTRATION FEE.

July 31, 1996


